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Chapter 1

Chapter 1
Introduction

1.1 Overview

This User’s Guide provides a comprehensive operating guide for ELAN‘s
UWTR Writer System in programming of ELAN EM78 Series FLASH chips
and industrial/commercial grade OTP chips (see separate Application Note
AN-UWTR 0001 for the detailed list of the supported chips). The system
consisted of an UWTR Writer (the hardware device) and the UWriter software.
The software incorporates the software peripheral driver that drives the UWTR
Writer. The latest version of the UWriter software and it accompanying UWTR
driver can be downloaded from ELAN’S Website

NOTE

Visit the ELAN website http://www.emc.com.tw to download the latest UWriter software which
incorporates the UWTR Writer Driver.

The UWTR Writer device supports both on-line and offline (stand-alone)
programming operations.

1.1.1 What You Should Get?
B One UWTR Writer B One Adaptor Board

B One each USB Cable, ISP Cable, &
Power Adaptor

Figure 1-1 UWTR Writer Hardware Package

UWTR Writer User’s Guide Introduction e 1



Chapter 1

The UWriter software, its accompanying UWTR driver, and this User’s Guide
are available and can be downloaded from ELAN’S Website.

1.2 Writer Hardware Attributes

FleEREE]

@ m

Figure 1-2a UWTR Writer and its Major Components

DC Power Jack (18V 800mA) LCD Panel (display programming data/status)
USB B Type Port (connects to PC) Connectors for SOP/SSOP/QFP/LQFP1

LED (indicates result status: Pass: green, Fail: amber) & other unique IC packaging adapter boards
Up & Down Buttons (scan & select modes/info) - Extension Connector for target board ISP2
Mode Button (set the selected program mode function) Universal Connector for unique IC PCB adapter1
Program Button (run the set program mode function Textool for DIP ICs

1
See the Application Note AN-UWTR 0001 for the detailed list of applicable SMD socket/Textool
and PCB adapter for each of the supported chips

2
In-System-Programming extended pins:

RESET 1 2 PVDD
OEB 3 4 ACLK
PGMB 5 6 DATA
DINCK 7 8 o
'Il 9 10 ~° PVPP
ISP Con.

Applicable pins for OTP chips:  2: PVDD 3: OEB 4: ACLK 5: PGMB
6: DATA 7: DINCK 9: GND 10: PVPP

Applicable pins for FLASH chips: 1: RESET 2: PVDD 6: DATA 7: DINCK 9: GND

Figure 1-2b In-System-Programming (ISP) Connector Pin Assignments

2 e Introduction UWTR Writer User’s Guide
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1.2.1 Textool (Socket)

1.2.1.1 Textool for DIP Packaged Chips

The Textool can accommodate Pin 1
various sizes of DIP packaged
OTP/FLASH chips. When
mounting a 40-pin chip into Textool,
make sure that the chip is positioned
in such a way that its notch (Pin 1) is =
on top (pointing away from the
Textool locking lever). If the OTP
/FLASH chip has less than 40 pins,
the chip should be installed bottom
aligned with the Textool as
illustrated at right. This position
ensures that the pin numbers of both Textool lever 0
chip and the Textool are matched.
Otherwise, the UWTR Writer will Figure 1-3a Proper Mounting of Chip into Textool
not function properly

40

o
32

20
14

l uld -3
'W""TWW

AL IO

Align chip
at the bottom

\

1.2.1.2 SMD Textool + Adaptor Board for SOP/SSOP/QFP/LQFP
Packaged Chips

SMD Textool mounted on an applicable adaptor board is used to accommodate
various sizes of SMD SOP/SSOP/QFP/LQFP packaged OTP/FLASH chips.
The adapter board is inserted into the two connectors adjacent to the DIP
Textool (attribute “H” in Figurel-2a in Section 1.2 above).

Figure 1-3b Mounting SMD Textool + Adaptor Board (with Pin Height of 18mm) on UWTR Writer

UWTR Writer User’s Guide Introduction ¢ 3
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1.2.2 Programming/Mode/Up&Down Button Functions
and LCD Panel Display

The LCD panel turns on as soon as power is supplied to the UWTR Writer. It
= displays the instructions and corresponding information as set through the
H Program/Mode/Up&Down buttons during offline (stand-alone) operation. It

also displays the results of such instructions after pressing the red Program

button.

1.2.2.1 LCD General Functions Display Allocation

Figure 1-4 LCD Panel Display Allocation

Area A) Displays mode setting and program results status:

e When in offline (stand-alone) status, this area will initially display
the currently applicable adaptor board number ADPXXX.

e Press Mode button to activate the program function selection
mode on Area A. Then press Up/Down buttons to scan and select
for required function, i.e., Erase (Flash chip only) 2 B/Check 2
Write =2 Verify = Auto. Next, press Mode button again to apply
the selected setting and press the red Program button to execute (if
the info displayed in Area B & C are okay).

e |f the executed function is successful, *Pass* will display at the
right end of this area and the LED lights up with green color.
Otherwise, it will show *Fail* and the LED lights up with amber
color.

4 e Introduction UWTR Writer User’s Guide
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Area B) Displays OTP/FLASH checksum or failure message:

e Under normal condition, this area will initially display the source
code checksum.

e When the installed Adaptor Board does match with the loaded
source code, this area will display Adap-Board Error.

e If the target chip is not installed or not correctly positioned on the
Textool, Check on Socket message will display on this area.

e |f the selected target chip type and the Adaptor Board do not
match, or the chip is not correctly positioned on Textool, this area
will show Check on Socket or IC doesn’t Match.

Area C) Displays Program information

e When in offline (stand-alone) status, this area will initially display
the UWTR Writer hardware device version.

e Press Up/Down buttons to select for the required programming
status information, i.e., Code Option = IRC/WDT Frequency 2
Written Count - Summary Count 2 Rolling Code.

NOTE
All UWTR buttons are disabled when it is connected to PC.

UWTR Writer User’s Guide Introduction ¢ 5
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1.3 Programming Operation Flowchart

NOTE

It would be helpful to print this page and use it as ready reference while programming

Install UWriter software and UWTR hardware

Y

Start UWriter software

Y

Update UWTR firmware . Connect PC, select target IC

1 |
Y

Change programming file — .AOP or .ZIP file
> Open programming file
y CDS file A
Setup Code option .CDS i Save as AOP file
Select download location
and download file to UWTR <

!

Programming

Continuous programming
L

Y

!

Perform [Program]—[Auto] Press the red button on UWTR

On-line programming *

+Off-|ine programming

v

Check programmed IC result (Pass or Fail)

Passed

Y

Failed

Y

Place in “Accept” bin Place in “Reject” bin

Y

v

Programming Completed

Figure 1-5 Programming Flow Chart

6 e Introduction
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Chapter 2
System Installation

2.1 System Requirements

2.1.1 Host Computer

The UWTR Writer System requires a host that meets the following
configuration:

1. IBM PC or compatible computer

2. Runs under Windows 2000, NT, XP, or Vista
3. 6MB free hard disk space

4. Mouse

2.1.2 External Power Source

Requires power source of +18.0VDC, 800mA (power adapter) to provide power
for UWTR Writer Main Board.

NOTE
Use of ELAN provided AC power adapter is recommended

2.1.3 USB Cable

Use the standard USB cable with A & B male connectors. Length of cable
should not exceed two meters (6.6 feet)

NOTE
Use of ELAN provided USB cable is highly recommended

UWTR Writer User’s Guide System Installation e 7
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i

2.2 Hardware Installation and Setup

2.2.1 Connecting UWTR to Host Computer and Power

Source

Be sure the Textool is empty before supplying power to UWTR. Otherwise, the OTP chip
could be damaged.

CAUTION!

Power 4

USB

1.

N

w

&

Choose the appropriate Adaptor Board for the target chip and carefully plug
it into 64-pin “Adaptor Board Slot” on the right side of the UWTR Writer.
Make sure the pins are correctly aligned, not shifted to left or right.

Plug the power adapter (DC +18V) power jack to the UWTR Writer power
connector and plug the adapter to a power source. The LCD should display
ElanUWTR.

Plug the USB cable between UWTR Writer and PC anytime you want to
connect and control the writer with UWriter program with PC. If the
UWriter program is running in your PC, it will auto-detect and link with the
UWTR Writer. Note that all buttons on UWTR Writer are disabled when it
is connected to PC.

Plug the target chip on Textool by referring to Section 1.2.1 for proper
procedure. Also be sure that the Adaptor Board matches with your target
chip.

\
.
/

|- Adaptor Board

f
|

UWTR

Figure 2-1 Connecting UWTR Writer Assembly to Host Computer

8 e System Installation UWTR Writer User’s Guide



Chapter 2

2.3 Installing the Software (UWriter Program &
UWTR Driver)

2.3.1 Downloading UWriter from ELAN Website

The latest version of UWriter software (incorporating the non-integrated
software peripheral UWTR Writer driver) is available from the ELAN’s
website (http://www.emc.com.tw). To access the software, do the following:

1. From ELAN homepage, click Technical Support - Supporting Tools -
Microcontroller as illustrated below.

T ELAN Microelectronics Corp. - Microsoft Internet Explorer gy - ELAN Corp. $2{it

Fie Edit View Favorites Tools Help q
Ok - © W @ @ Pserch Jeravones @ (22 @ - [JE B
Address|@1 http:/fwwaw.emc.com.tw/eng/index.asp V|Go Links ” | €

L | site M | @bz | #wiEex |
% BERIREARAT oo in - = f TaP )
ELAN MICROELECTRONICS CORP. fFHome l:l @/ Search
About Elan Applications Products Technical Suppo ELAN News Investor Relations Human Resources

Supporting Tools » Microcontroller N \HTGH‘OCG Expen

n

T
Supporting Documents } Telecommunication IC

PC Peripheral IC

Supporting Tools/Doc Update ¥

¥ Audio/Video IC L4

Q&A

Web Account Registration NB Input Device Module ¥

Figure 2-2a ELAN Website Homepage with “Technical Support” Button 2 “Supporting Tools”
2 “Microcontroller” Selected
2. Then under “IC Part No.” column of the “Microcontroller” list of ICs, look
for “EM78F651N/EM78F651N” (or for “UWTR” under “Tools” column)
near the bottom of the list. Then click, File button under the “Download”
column as illustrated below.

| Supporting Tools  »  Microcontroller

Supporting Tools g ! i Qes ContactUs

Item Version Description @Iease Date

and Windows XP

EM78P459
Software far MTP Writer which supports WINGE,
Software V14 wiindows ME, Windows NT4.0, Windows2000 OFile 20057312

EM78M447 MTPATR and Windows P

Bt fugr forWiINas, wirgs,
Setup Driver V1.0 Windows ME, Windows NT4.0
and Windows #P.
Software for FWTR which supports WIN95,
Sofware Vi WHINGE, Windows ME, Windows NT4.0,

Wiindows2000 and Windows +P for
Em;:ﬁg:;x FWTR EMTEFES1MNIFEAIN
Setup printer port driver for WINGS, WINGE,
Setup Driver V1.0 windows ME, Windows NT4.0, Windows2000
and Windows XP

2005372

200761

20068120

EM7BP153E oftware Simulator for
_______ _EMARBAAEE _ e T L L _®Hle____opustr. o _

Figure 2-2b Accessing UWriter Software by Clicking “File” Button

UWTR Writer User’s Guide System Installation ¢ 9
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3. You will then be
prompted to either
“Open” or “Save” the
“UWriter installer
XXX XX.exe” file. If
you choose to open the
file directly, the web
browser will download
the file to a temporary
folder and execute it. If
you choose to save the

@ Some files can harm wour computer. If the file information below looks

suspicious. orvou dao not fully frust the source. do not open or save this
file

File name: . MWriterver 3_&_SA NOTE zip
File type:  WinZip File

Frarm: WA, B TIC. CO. T

Would vou like to open the file or sawve itto wour computer?

Open | Sawve I Cancel | More Infa |

v Always ask befare opening this type of file

Figure 2-2c UWriter Installer File Option Dialog

file, you have to execute the installer from your PC.

2.3.2 UWriter Program / UWTR Driver Installation

If this is your first time to install UWriter software, it is recommended that you pre-connect the
UWTR Writer hardware device to your PC with its power on. Otherwise, the UWTR Writer
driver portion of the software may not install properly.

NOTE

1. Aton-line execution of
the installer file, the
splash screen (shown at
right) will appear.

g

U Writer inataller 100,00
The same installer splash
screen will appear if you

click the installer icon

from your PC (i.e., when

executing the installer
file locally).

2. Then the UWriter Setup

Wizard dialog pops up
(figure at right) with

welcome message. Click

the Next button to
continue as instructed.

Il”IIA”!II!!L'A!OI”-I
e '
| B

= UWriter

USB Writer v1.00
m ELAN Microelectronics Corp.
2

Figure 2-3a UWriter Installer Splash Screen

® UWriter Sstup ~=10] x|

Welcome to the UWriter Setup
Wizard

This wizard will guide wou through the installation of Uwriter,

It is recammended that you close all other applications
before starting Setup, This will make it possible to update
relevant systen files without having to rebaat your
computer,

Click Mext to conkinue,

Cancel |

Figure 2-3b UWriter Installer Welcome/Setup Dialog

10 e System Installation

UWTR Writer User’s Guide



Chapter 2

3. You are now prompted  [Eygm—=—" x|
tO SeleCt the UWI’itel’ Choose Components ‘
ComponentS tO be Choose which Features of UwWriter you want to install, t@

inCI Uded in the inStaI I- Check the components you want to install and uncheck the components you don't want ko
. . install, Click Mext to continue.

lation by selecting the

check boxes of the

Select components ka install: Liwriter Core Files (required)
1 1 Start Menu Shorkcuts
options provided as e
Shown in the rig ht Remove previous User interface setting

figure. After selecting,
- — Description
CI ICk the NEXt bUtton to Space required: 4.5MB Positioi wOUE MOUse Over a component to see jts
- description,
continue to the next
Tullsoft Install System w2, 44

Step' < Back I Mext = I Cancel |

Figure 2-3c UWriter Installer Components Selection

4. Define a folder

. . . ® U'WWriter Setup 0 I ]
|0C8.t|0n Wlth WhICh tO Choose Install Location ‘
Insta” and Store the Choose the Folder in which to install Liwriter. t@

UW“ter prog ram . The Setup will install Usriter in the Following folder. To install in a different Folder, click Browse
- and select anather Folder, Click Install bo stark the installation.
default folder path is

“C:\ProgramFiles\

ELAN\UWriter.”
C"Ck Insta” button 0 Destination Folder
start installation. { Brows. .

Space reguired: 4.8ME
Space available: 4.6GE

Tullsoft Install System w2, 44

< Back I Install I Cancel |

Figure 2-3d Define UWriter Installer Folder Location

5. For first time install-
lation, the UWTR

s WTR Driver Installer x|

B . IE[ ELAN Microelectronics Corporation
Driver Installer dialog | #) UWIR

will also appear to Dufver Version 3.1

prompt you to install
the UWTR Writer
driver. Make sure the
UWTR Writer device is Figure 2-3e UWTR Driver Installer Dialog
linked with your com-

puter with power turned on, then click the “Install”” button to continue.

Cancel |

NOTE
This dialog will not appear in the subsequent installation of the UWriter program unless the
UWTR Driver has previously been removed from the computer.

UWTR Writer User’s Guide System Installation e 11
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6. When the whole @ UWriter Setup RRE e
installation process is Completing the Uwriter Setup
completed, the ‘ wizard
Comp I et'on message Uiriter has been installed on vour computer,

W| I I d isplay as ShOWﬂ @ Click Finish ko close this wizard,

in the right figure. You
may also choose the
option to run UWriter
automatically after
clicking the “Finish”
button.

= Back I Einish I Cancel

Figure 2-3f UWriter Installer: Finish

2.3.3 UWriter Program / UWTR Driver Re-installation

If for some reasons you want to reinstall the UWriter software, you need to first
remove the existing program from the computer (see next section for the proper
uninstall procedure of the program). Otherwise, the following dialog with a
reminder message will display.

UWriter Setup

'E UWriter is already installed.
. The previous installation wil be removed.

[ OK \ l Cancel ]

Figure 2-4a “UWriter Already Installed” Message

However, if you click the “OK” button of the dialog, the UWTriter Uninstall
Welcome dialog (see Figure 2-6a below) will automatically appear to make you
perform the required UWriter uninstall process as described in the next section.
After the uninstall process is completed, the installation process dialog
(described in the previous section) will then automatically follow.

12 e System Installation UWTR Writer User’s Guide
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The UWriter Uninstall applies to the UWriter program only. The UWTR
Writer driver will remain intact and not affected by the UWriter uninstall
process. If you attempt to reinstall the UWTR driver by executing the UWTR
Driver Installer (see Fig 2-4e) from Windows Start Menu without removing
the driver first, the following message will appear. See Section 2.4.2 below for
proper way of uninstalling the UWTR driver.

Notice

é) These drivers are already current and up to date, to remove these go to Add/Remove Programs in the Control Panel

Figure 2-4b Message when Attempting to Reinstall the UWTR Driver Prior to its Removal

2.4 Uninstalling the Software (UWriter Program &
UWTR Driver)

2.4.1 Uninstalling the UWriter Program

You may uninstall the ® UWriter Uninstall o] x]
UWriter program with one
of the following:

1 Execute the UWriter
installer again in the
system without remo-
ving the previously
installed UWriter. The
UWriter Uninstall
Welcome dialog (figure
at right) will automati-
cally display as
explained in previous
Section 2.3.3.

& uninstal | 2. Execute Uninstall icon from Windows Start Menu ([Start] > [Programs]
- [ELAN] = [UWriter] = Uninstall). The above dialog will then appear.

Welcome to the UWriter Uninstall
Wizard

This wizard will guide vwou through the uninstallation of
Lidfriter.

Befare starting the uninstallation, make sure UWriter is not
Funning.

Click Mext bo conkinue,

Cancel |

Figure 2-5a UWriter Uninstall Welcome Dialog

3. Execute the “Add/ Remove Programs” from the Control Panel. Then find

: and click the UWriter from the list of programs. When the Change/Remove

Bl vwrter button is clicked, the UWriter Uninstall Welcome dialog (figure above)
pops up.

From the UWriter Uninstall Welcome dialog, click the Next> button to
continue.

UWTR Writer User’s Guide System Installation e 13
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The UWriter Uninstall ® UWriter Uninstall o x]
dialog will then show the |ttt 2
path where the UWriter

will be removed from. Uwriter will be uninstalled From the Following folder. Click Uninstall o start the uninstallation,
Click Uninstall button to

continue.

Uninstalling fram: — [C:iPragram Files\ELANLriter
After uninstall process is
completed, the dialog will
announce the completion
and prompt you to close
the uninstall wizard
(figure below)

fullsoft Install System w2, 44

< Back

Cancel |

Figure 2-5b UWriter Uninstall Dialog Showing Program
Location

& UWriter Uninstall JECN [ ] |

Completing the Uwriter Uninstall
Wizard

Uwriter has been uninstalled From your computer,

Click. Finish to close this wizard,

= Back

Cance |

Figure 2-5¢c UWriter Uninstall Dialog Announcing Uninstall Completion

The UWriter Uninstaller will not remove the UWTR Writer driver as it is not
advisable to do so. However, if for some reasons you find it necessary to
remove the UWTR driver, you may do so by following the steps described in
the following section.

14 e System Installation UWTR Writer User’s Guide
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2.4.2 Uninstalling the UWTR Driver
You may uninstall the UWTR driver with one of the following:

1.
[ uninstal uwTR Driver]

2.

i UWTR (Driver Removal)

Execute Uninstall UWTR Driver icon from Windows Start Menu ([Start]
- [Programs] = [ELAN] = [UWriter] = [Driver] = [Uninstall UWTR
Driver]). The dialog illustrated below will then appear.

Execute the “Add/ Remove Programs” from the Control Panel. Then find
and click the UWTR (Driver Removal) from the list of programs. When the
Change/Remove button is clicked, the dialog shown below will then pops

up.

0 ELAM Microelectronics Corparation
UWTR

Driver Version 3.1

Uninstall Cancel

Figure 2-6 UWTR Uninstall Dialog

Click the Uninstall button to apply uninstall.

UWTR Writer User’s Guide System Installation e 15
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Chapter 3
Getting Started with

UWriter System

3.1 Starting the UWriter Software

With the powered-up UWTR Writer properly connected to your PC, execute the
gl UWriter program either from desktop shortcut, or from Windows Start Menu
Wi ([Start] > [Programs] - [ELAN] - [UWriter] - [UWriter]). The main

Click Program —
- Select MCU to |
display Select MCU <=
dialog if it does not

appear

» =] ¢ B
Frotec: _ fin. ad i Bark Check  Venly Frd  sboust s

8 X Sarce

Code Cption Word

Cowth

s e Nt cORTRCIRD NUM COR 507

Figure 3-1a UWriter Main Window Before Data are Entered

The Select MCU dialog will pop-up if your UWTR Writer is already connected
to PC. Otherwise, from Menu Bar, click [Program] - [Select MCU] to
manually display the dialog (or click the Select MCU icon from the toolbar). If
the UWTR is not connected, an error message “Connection is lost” will display
instead.

Note that the above main window is blank and shows no data. After the
required data are provided in the Select MCU dialog, the main window is then
filled with corresponding data as shown below.

UWTR Writer User’s Guide Getting Started with UWriter System o 17
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UWriter version: 0.09.04 (UWTR firmware version: 0.0801) EMTSFEEINDI =15]x]
Menu Bar —msie view pogam gead Tool Abou
. CIJ S:ad S«;I:ﬂ &d B‘s w"iP .ﬁ& P. Ei ?Ch' B?k V‘)’:f h}:d Ai:w
if fect
TOOI Bal’ ,|70pen ey Ve 35, & TaBe. Tite  Auto  Frofec 2 ip Cl::lct erify il

. Source (PN John 535\ kohn ods) checksum: TE5A rax

o o [ Jas[«sTs] s a]c]o]=e]rH
1605 0005 IBD6 0008 IBOE OOOB 180C 0OOC 1EOD OOOD IBOE OOOE 18OF OOOF 15FS 0003
18F6 0006 I8FE OOOB 1BFC 00OOC 18FD 000D MSFE OOOE 1SFF OOOF 1810 0050 18))-<aall—1— Source

eI |
A
i |
£ g glels 2 §lb
rgeaill
Blsle

1812 0052 1813 0053 1804 0054 1815 O0SS 1816 0056 1817 O00ST 1elE O0Se 1819 UE:;J
Corde Orption Wowd | 0000 ad (Online Buffer) checksum: 756 4 v a
Code Option || otz | o0 o[ 1Ja]s]e]s]ela]e]s]afe]c]olelrp
nd Checksum ERAEL L o o |hes ows 106 o005 10D 000D 180C GOOC 180D OOOD LME OOOE LeOF COOF LEFS 005 .
a ’ Ll FTURTAL Bl - 1M FTUCTAL SMta- It | |70 ] ygrg 006 Me7B 0OGD ISFC GOOC IAFD OKID ISFE OE ISFF OGP 1810 0030 191 TEE—T— Read Window
Window EHWETR fskle fuile 20 | 1812 0052 1H13 0033 1EIA OO 1EDS OGNS DEI6 D036 1E1T 0037 181E cosE 1819 cosw =
Inimetion Paried e sl EEFROM Source (~empEED) check... = @ x |EEFROM Read (Online Bufter) chec -3
== = il |8 00 BEnEOEnONOE S| N ONERNEORNONOGRE)
o [a[s[s[s[s[*[s[s[a]e]c[o =] [ Tels[z]s]s]s]s]7]s]s]a]s]c]o]=]
EEPROM ::1. ';h T: o [o0 0000 00 00 00 00 00 0900 00 00 00 00 | 000 50 00 o0 0 00 50 00 00 00 00 00 00 20 EEPROM
Source Tt | ™ ™ T wwwwwwwwmmmn_nld J_Ui_wmmmwwwmmmmmmaf_ReadWindow
Window | fmesrom | . (- — L _—
HLP Dbl Disable _,;l Frogrammed Counls L
T — N | Programmed
TP EELIE M e : —— CounterWindow
B A aaEaBaa e noe™

CoMOpticaWerd0 |0 0 0 000 0000000 000

Code Option

— Output Window
Wordwlndow_wml @ ¢ 0 0000000000 M

ColOpticaWerd2 (0 0 0 00 1 0000000 M8

Status Bar — = T S }CU: EMTSFEGLNDLG Connecied  |NUM|CAFCRL
Figure 3-1b UWriter Main Window After Data are Entered

The size or location of each window can be changed. The Menu Bar and Tool
Bar (its corresponding shortcut keys) can be customized.

3.1.1 Select MCU Dialog

From the dialog, select your target MCU and target board VDD. Make sure
the Adaptor Board that is connected to your UWTR Writer matches with the
model number shown in the dialog. Enter MCU keyword

o or TACY (last 3 digits) to
Selcci Ao x| | facilitate display of
Fiter 1  short-listed target

MCU : [EM7BFEETND16 N MCU selections
{ex: 153 NJ .
Select & enter Target MCU — Indicates the Adaptor
Target board ¥YDD ’I 5V [Default] j Board model number
Select & enter your Target Board VDD — relative to the selected
Adaptor board : | ADP024 —=———1""\|CU. This should

match with the actual

Cancel | board installed

Figure 3-2a UWriter Program “Select MCU” Dialog

By entering the keyword (last 3 digits) of your target MCU on the Filter text
box will cause the MCU drop-down combo box to display only the short-listed
selections of the MCUs and speed-up the selection process as illustrated below.

O~ Filter / \ Filter Filter
EM78FEB1ND16 A EM78P153SP = |( 153 ) (EM78P1538N NS
EM78P1535P <] [exT53 N| [ ETs R (ex: N) (ex: 163 N
EM78P153SN EM78P1535N/ |

EM78P154NP — *| Warr Voo 5V UeTan -|30ard VDD : |5V (Defauly =
EM78P154NM

EM78P156ELP —

EM78P156ELM g4 ptor board : I ADPOG4 ptor board : I ADPOGBA
EM78P156ELAS -

Figure 3-2b “Filter” Text Box Keyword Input Function Demo
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Every MCU support one or more programming voltage (Target board VDD).
The Target board VDD combo box will list all the support programming

voltage accord

ing to the target MCU you selected in the MCU combo box. It

should to be note that the target board VDD you select will infect the UWriter
supported count of IRC frequency and LVR level. Please refer to the section
“3.2.2 Code Option Dialog” for detail.

Plsc.coce
Filter Filter
MCU : [EM70FG72NAP | MCU : [EM7BF6EANK24 | [ ssa
ex: 153 N) (ex: 153 N

| Support 5V and

Target board ¥DD : |5V [Defaylt] - Target board ¥DD : |5V [Default] ? 3V .
5V [Defauli programmlng
Only support T A—
— aptor board © ADPO36 Adaptor board : FOTO

5V programming

Cancel Cancel
Figure 3-2c every MCU support one or more programming voltage

dialog.

B You can process your “*.CDS, *.OPTION, *.AOP, *.EED, *.TXT, *.ZIP" files in the UWriter
main window without connecting your PC with the UWTR Writer.

W After connecting your PC to UWTR later, click on the “Select MCU” icon from Tool Bar (or
click [Program] = [Select MCU] from Menu Bar) to manually display the Select MCU

B If you set the Target board VDD to 5V first and change it to 3V in the same UWTR
instance, an error message dialog will pop-up and we will close the opened file if it include
the Code Option which 3V doesn'’t support.

W For factory firmware, every time after you select target MCU, the Log Setting dialog will
pop-up automatically to make a log for your according operation.

NOTE

3.1.2 Stat

/ Status Progress

Ready

Where:
Status

Progress Bar
Selected Target MCU

Connection Status

Selected Target board VDD

us Bar

PC to UWTR
Selected Selected Target Connection

Bar Target MCU\ Board VDD\ / Status
Iinmcu: EM7EF652ND16 |5vjconnected |um[car]scry]

Figure 3-3 UWriter Program Status Bar

“Ready” indicates UWTR is ready to process next command. It
will also display the command selected from Menu and Tool
bars and the “Running” while the command is running.

Shows the progress (% completed) of the executed command
Shows the current target MCU on programming processes

Shows the PC to UWTR connection status. 1f UWTR is not
connected to PC, [Not connected] will also display on Title bar

Show the current target board VDD value

UWTR Writer User’s Guide
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3.2 Loading Source File to UWTR Buffer
3.2.1 Open File Dialog

File | From Menu bar click [File]>[Open...]. When the Open
|7 Open... Cul+0 |  dialog displays, select and open the applicable source file
4 Close Ctrl+ W (i.e., *.CDS, *.0OPTION, *.AOP, *.EED, *.TXT, or
i Save as Ctrl4g *.ZIP”) for the target MCU from your folder.
Exit Alt+F4 Open 21X
ook in; | == Local Disk (F: v O F > m-
Figure 3-4a “Open” Source File ook Local Disk () (e]
Command from “File” Menu giﬁfg}éﬂ g E:Sm;sst&:
I) BackupFiles
IC)FOUND.OOO
My Documents
() New Web
[ Outlook Express

System Volume Information

Files oftype: All Supported Files(".cds™.aop” eed" bt zip) ¥ Cancel

|All Supported Files(*.cds:* aop:* eed:™ it * zip |
ROM Codes Files(*.cds] k

AOP Package Files(*.aop)
EEPROM Data Files(*.eed)
EEPROM Data Files(™.td)
ZIP Package Files(* zip)

Figure 3-4b Opening a Source File from Folder

NOTE
For EEPROM type MCUs, you can open the *.EED source file any time you want.

If your target is an EEPROM type MCU and you have not opened the *.EED file, you can
directly key-in the data into the EEPROM Source window. This is only allowed if you have
not opened the *.AOP file.

For outsourced factory firmware, every time after you open a new or different *.CDS or

* AOP file, the Log Setting dialog will pop-up automatically to prompt you to log-in the new
*.CDS or *.AOP file.

DO not open file (*.AOP, *.ZIP, or *. OPTION) with a Code Option that is not supported by
the currently set Target Board VDD. You must change the Target Board VDD setting to
match with the file and try again.

ROM Codes File(*.cds) cannot be written into chip. User must save as AOP Packages
File(*.aop), and open AOP Packages File(*.aop) to write to chip.
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3.2.2 Code Option Dialog

Once you have opened the *.CDS file, the Code Option dialog will pop-up.
You only have to click on the items that you need, then click OK button to
confirm your selection and apply it to Code Option and Checksum window.
You can display the dialog again to modify your selection anytime by executing
[Program]->[Set option] from Menu bar.

+ Code Uption J_Dl_l x|
RESETB o /RESET @ P17 Al Click to maximize
VDD resebielease level O 40VA.2Y o 3.5VATV this dialog
C 27v/29Y ® NAMNA
COBSAa O IRC Register select ® IRC Optien select Red string means
Green background RCQUT L Cpen dram ® System clk the value is
means the item you T Cscillator O ERCPEI/OSCO st P81 ;’Wﬂﬂs@—“. — different from
are currently focusing If(-: IRC PR1/OSCD act P81 TRC P8 L/OSCD act 0SCO before.
LXT2 O LXTI
Red background o HXT2 O HXTI
means the item O KT
relative to what you __f" 455KHZ = BMHz Ll
are focusing. - 16MHz @ AMHz
Be sure to check HLP O Law ® High Edit Custom ID
this item. Custorn ID(HEX) iF —= o directly with
=— = — = = keyboard
Drag border to //git 2]lulw]s]s]7]e]s]al3]2]1]0] vaue] .
change CodeOptionWed® | 1 1 1 1 1 1 1 1 1 | 1 1 1 IFFF All code option
sub-window size Code Option Ward 1 | 1 1 11 1 SIS RN 1 rEs i Word_s status
CodeOptionWod2 | 1 1 I L 1 1 @& 1 1 1 1 1 1 IFBF are displayed
S here.

Figure 3-5a UWriter “Code Option” Dialog

If you select IRC mode as Oscillator mode, the IRC frequency will be
calibrated in the programming process. In this process, the MCU should work
properly. However, in some frequencies, the MCU will only work properly
under specific programming voltage (Target board VDD). Hence, the Code
Option dialog will only display the frequency value that supports the
programming voltage you have selected in the Select MCU dialog.

In addition, if you set the Target board VDD combo box at 3V, it is assumed
that your application circuit power supply voltage is 3V. If you select the LVR
level which is above 3V in the Code Option dialog, the MCU can not be
properly setup under this condition. To avoid this situation, the LVR level
which value is above 3V is masked if you set the Target board VDD to 3V.
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Select HCU |

MCU : IEM?BFBBdNKZd

Target board ¥DD : [5¥ [Defauly |

Adaptor board : | ADPO37

Cancel |

Figure 3-5b Setting the Target Board VDD
at SV.

When 5V is selected as the Target
board VDD, all four IRC
frequencies and LVR level are
supported and displayed in the Code
Option Dialog

Select HCU ] |

MCU : IEM?BFBBdNKZd

Target board VDD : z

Adaptor board : | ADPO3T

Cancel |

Figure 3-5d Setting the Target Board VDD
at 3V.

When 3V is selected as the Target
board VDD, the MCU can not work
properly under this condition as the
IRC is 16MHz and the LVR level is
set at above 3V. Hence, IRC and
LVR values are not displayed in the
Code Option Dialog.

=T
Protect @® Disable (& Ensble =
Filter Mode C XT(ETAL BNHz ™ IMHz) o HUT (i gh XTAL 16MHz ™ GMHz)
j I o LTI (Low KTALL IMHz * 100KHz) » LHTZ (Low XTALZ 32KHz)
[BX: 153 N] ® IEC 54 act as I/0 pin i TRC F54 act as RCOUT pin
» EEC PS4 act as If0 pin w ERC PS54 act as RCOUT pin
ERVDTE @ Disable (] Ensble
Instruction Period ® 4 clocks o 2 clocks
» 8 clocks - 16 clocks
FEE @ Enable O Dissble
FRHL @ 32/fe O /e
Heset Level c WA o 277
»(" 3.7 F a1y
Frequency (WHz) L 4 Ic 16
L 8 @ 455K
TCER @ 777 G ToC =
Mztam THIHRYD nn ;I
Bit 12 ‘ 11 ‘ 10 ‘ E] ‘ 8 ‘ 7 ‘ ] ‘ 5 ‘ 4 ‘ 3 ‘ 2 ‘ 1 ‘ i ‘ Valu: L;
Code Option Hord 0 0 0 i i o o 1 a i i i 0 o020
Code Option Hord 1 0 0 1 1 i 0 ] ] 0 o 1 z B oer ||
Code Ontion Hord 2 0 0 0 0 0 1 o0 i 0 0 0 ooeo x|
cancel
Figure 3-5c¢ the 5V according Code Option dialog
ol x|
Protect ® Disable O Enable
Filter Mode ® XT((TAL BMMHz ™ LMHz) o JOLT (i gh KTAL 18MHz ™ Bz
j | C LTI (Low XTALL IMHz ™ 100KHz) g LHT2 (Low XTALZ 32Kiz)
[BX: 153 N] @ IRC BS54 act as IO pin - TRC F54 act az RCOUT pin
» ERC PS4 act as I/0 pin i ERC PS4 act as RCOUT pin
ENADTE @ Dissble o Enable
Instruction Period ® 4 clocks C 2 elocks
» 8 clocks O 16 clacks
FEE @ Enable o Disable
FRHL ® 32/fe - /fe
Reset Level +’¢' A I 2.7
Frequency (iHz) 0 4 - 8
£ 455Kz
TCEN ® BT s} e
Custen INGET) o0
Bit 12 | 1 ‘ 10 | E | 8 ‘ 7 ‘ & ‘ 5 | 1 ‘ 3 ‘ 2 ‘ 1 | i ‘ Valu: L;
Code Option Word 0 o 0 ] 0 0 o i 0 0 a 0 0 o0z0
Code Option Word 1 0 0 1 1 0 0 ] o 0 0 0 [ oso0 |
Code Option Word 2 o 0 0 [ 0 E il i 0 0 0 0 0 |
cancel

Figure 3-5e the 3V according Code Option dialog
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3.2.3 Load Dialog

i x
From Menu bar, click : A
Load Region
[P rOg ram] 9 [Load] to ’V “ Onhi { ftne ‘ ¥ Load with EEFROM Data
dISplay the Load d|alog st 10000 (D) (0= urlirited)
(Figure 3-6a). Select the Load | [retinesece
. . . v Use Rolling Code for ROM Codes
Region option box first. Its RO Cods |

default value is Online. If you RatingCodeByss [ 4 4| ]

H Addresses (Hex)
Want to use Of:fllne pljogram7 &thByte TthByte 6thByte SthByte dthByte 3rdByte  2ndByte LowBwte
select the Offline option. In

[[omo [ o [Two o [ ows [ ooos [ oooa | ooz

addition, the default program- g e R
ming count limit is “0” or ot 1B @ e e
unlimited. If you want a

limited count, enter a quantity o

value. And if you want to use Figure 3-6a UWriter “Load” Dialog

Rolling Code, enable the Use Rolling Code for ROM Codes check box. See
Section 3.8 for Rolling Code details.

For ICs which are equipped with EEPROM, the “Load with EEPROM Data”
check box option is available for selection. If this option is enabled, the
UWriter will load ROM code and EEPROM data into the buffer at the same
time. Otherwise, the UWriter will only load ROM code to the buffer, and all the
data in “EEPROM Source” window will show “-”. For ICs without EEPROM,
this option is not available or disabled.

NOTE
Some particular ICs that are equipped with EEPROM will have this option enforced as default.
Hence, the check box is enabled but the option is grayed. You cannot change the setting.
The default load operation is for the UWriter to load ROM code and EEPROM data into the
buffer at the same time.

Finally, press the Load button load data into buffer and observe the Output
window displays the following when loading is successfully carried out.

M4 » M Message:(Fmd,(COrnpere,(COrmnmt M4 » M Message,(Fhad:(Cbmpa:e/(Cbrmnmt

Btart to Load. ... _ .
Loading to buffer Succesded.

St 0o PBead from Buffefr—s - -

Peading from Buffer Succeeded.

Figure 3-6b “Output” Window Successful Data Loading Messages

3.2.4 Read Buffer

Read | Tool About

&% Read Chip F&

| Read Online buffer  F7 |
Read Cffline buffer

Figure 3-7 “Read Online Buffer”
Command

After loading process is completed, the system will
automatically read the data from the buffer. You can also
manually read the buffer by executing [Read]2>[Read Online
Buffer] from the Menu bar anytime.

UWTR Writer User’s Guide
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After reading, the Output window will also display successful reading result as
illustrated in the right figure of Figure 3-6b above.

3.2.5 Compare

Tool | About

#% Blank Check F5

& Verify Fo

| Cornpare |

&4 Eind Ctrl+F
Counter Report Ctrl+R
Log Setting Crrl+L
Writer Test Ctr+T
Font...
Customize...

Figure 3-8a “Compare” Command

After successful loading and reading, the system will
automatically execute Compare function to check and
confirm that the data in the buffer matches with that of the
source file. In fact, whenever the Source window contents or
the Read window content changes, Compare will
immediately execute automatically. You may also execute
Compare command manually by clicking
[Tool]-=>[Compare] from Menu bar.

If there are differences after Compare, The different address
will flash continuous to position difference quickly and
obviously.

Results of the Compare function are displayed in the Output window Message
tab. If the message announces a number of differences, click the Compare tab
to display the details of the differences. Double click on the highlighted line(s)
pointing to the dissimilar codes; it will jump to the address where the
differences occur in both Source and Read windows.

Note that the data in both Source and Read windows are partitioned into
different shades of background (top section is darker than bottom section). But
the background color will changed when address crosses a page.

When the background colors are steady, this means the codes are matched.
When the background color flashes, it indicates difference in data exists as
illustrated in the figure below.

0| s | p [ E r |4

— R |
<_ ROM Codes Checkaum 6E4C BESL
| Code Option iliasd-0 1EFE 1FFF
<_ Code Option Word 1 1234 1FFF
RESETENE P70 P70
Delay Time 0 ns Ons
HLP High High

RCT

HLF

Protect

CLES

ENWDTE

Q5C

ERC
high_freqency ligh_frequency
Disahle

ERC

Disahle
delocks 4eclocks
Disable Disable

Tal HTAL

Custor ID (HEX)

1234 1FFF

1| 2afsfafs[s|a]e|a]alr]fc]
\FFF 1FFF IFFF 1FFF 1FFF 1FFF 1FFF IFFF IFFF 1FFF LFFF 1FFF LFFF 1FFF IFFF 1FFF

1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF
1801 1802 1803 1304 1805 1806 1307 1303
1FFF 1FFF 1FFF 1FFF 1FFF IFFF 1FFF 1FFF
1IFFF 1FFF 1FFF 1FFF 1FFF 1FFF I1FFF 1FFF

1FFF
1802
1FFF
1FFF

1FFF
1200
1FFF
1FFF

=]
[
IFFF 1FFF 1FFF 1FF{QR3FEH |
1804 180E 120C 130"'&0
IFFF 1FFF 1FFF 1FFF WP 1FFF

IFFF IFFF IFFF 1FFF - |

1IFFF 1FFF

(Buffer: Online) c

4 5 & 7 -3 £l A E

1FFF
1FFF
1204
1FFF
1FFF

1FFF
1FFF
1805
1FFF
1FFF

1FFF
1FFF
1208
1FFF
1FFF

1FFF
1FFF
1807
1FFF
1FFF

1FFF
1FFF
1808
1FFF
1FFF

1FFF
1FFF
1509
1FFF
1FFF

1FFF
1FFF
1804
1FFF
1FFF

1FFF
1FFF
180E
1FFF
1FFF

1FFF

—
IFFF 1
180C 180 il
1IFFF 1FFF 1FFF

1FFF

Pead = 130EH.

: Source =

1800H ,

Figure 3-8b UWriter Display Showing Different Data Occurs after “Comparison” Function
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3.3 Saving File

File | Wiew Program Rej To save the data to your folder, from Menu bar click
5 Cpen... Ctrl+0) [File]->[Save as...]. Then just select the file type you want
el Close Ctel 4V the dat_a to be saved |n‘t‘o. For example, _|f you wanf,to saveitas
[ savess Cul4$ | AORP file, then select “AOP Packege Files(*.aop)” as
illustrated below.
Ezit Alt+F4 When saving as AOP file type, the EEPROM data of
Figure 3.9a “Save as...” Command EEPROM type MCU are also saved together with the file.
Biidite 21x
RERD: [ aE = * ¥ B
L T B [IProgramming
EE RS FRTERR CIRingtone
| 1canfig CITEL
_gdiplus [CJuskxpress_Libraries_v3
| Jgridctr|_demo=25 C1wedding
" 1Play CawicePlus
KN i
BREEHEW: | FEE
TFEAEAD): [ROM Codes Dafn Files(* ods) =] e |
RO Codes Data Files(* cds 2
ROM Codes & Options Text Biles(* ta)
Data Files(* ged)

Figure 3.9b Selecting a File Type to Save the UWriter Processed Data

3.4 Programming of OTP/FLASH Chip on Textool

Programming of your ICs can be carried out in 2 ways; namely online with PC
or offline (stand-alone) without PC.

NOTE

If programming is successful, *Pass* will display at the top-right of the LCD and the LED lights
up with green color. Otherwise, LCD will show *Fail* and the LED lights up with amber color.

3.4.1 Programming Online

Program | Bead Tool Abou With installation completed V\_/ith no problem and the source
48 Select MCU Ctl4b file properly loaded with Online selected on the Load Region
By e option box of Load dialog, you can now place your OTP/Flash
&l Load 0 chip into correct position on Textoc_>| (see Section 1.2.1). From
& Erase £S Menu bar, click [Program]%[erte] or [Program]->[Auto]
S Write £ to start and process programming.
& Auto F4 | Write command starts programming of the OTP/FLASH chip
@ Protect F10 | onthe Textool. Then read and compare the OTP/FLASH chip

codes against the source file. Then the execution result is

Figure 3-10a “Write” Command - -
displayed on the Output window.
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Auto command is the same as Write but performs some other tasks before
Write. It will run Blank Check command to check and ensure the
OTP/FLASH chip on the Textool is blank (writable).

B If the chip is blank, it will carry out Write command directly.

B If the chip is not blank and the chip is a FLASH chip, it will erase the chip
data first, and then run Write command.

B [f the chip is not blank and the chip is an OTP chip, the Write command will
not be executed and the procedure will stop.

NOTE
If you have set a count limit or activated Rolling Code (or both) in the LOAD dialog during
source file loading process, you cannot execute Write command. You must execute the Auto

command.
Eead | Tool about After the Write or Auto command is successfully executed,
4% Read Chip F6 |  the Read Chip command will execute automatically.
Read Opline buffer  F7 Moreover, the internal frequency (if applicable) is displayed.
Read Offline buffer Then the Compare command will automatically follow to

Figure 3-10b “Read Chip” Command ~ COMmpare data contents between source file and that Qf the
programmed chip. If you want to execute Read Chip
manually, click [Read]->[Read Chip] from Main menu. Refer to Section 3.2
for detailed information on Load dialog, Source & Read windows, Compare,
etc.

Then remove the programmed chip and place another blank OTP/FLASH chip
on the Textool, and repeat the procedure.

3.4.2 Offline (Stand-Alone) Programming (Without PC)

WARNING!

1. The USB cable must be disconnected from UWTR Writer to perform offline (stand-alone )
programming.

2. The following LCD error messages (if displayed) have to be corrected before offline
programming can be carried out.

& “Adap-Board Error” (Adaptor Board does not match with the loaded source code for
the target MCU).

& “Check on Socket” (Chip is not installed or not correctly positioned on Textool).

& “IC doesn’t Match” (Error message may occur when the chip and the Adapter Board
do not match or the chip is not correctly positioned on Textool)
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codes are matched 1. Disconnect the USB cable and plug the power
: jack of the power adapter DC +18V to the
UWTR power connector. The UWTR LCD
will then initially display the UWTR Writer
hardware device version. Two seconds later,
the LCD display auto-changes to show source
code checksum and code option (Fig 3-11a).

NOTE
Make sure the Adaptor Board is properly installed and
the Source Code has been correctly selected and the
Load Region option box of Load dialog has the Offline
selected.

Figure 3-11a LCD Start-up Display & Subsequent
Auto-Display of Source Code Checksum & Code Option

2. Press the Down/Up button to scan and view the programming setup status
information (sample figures below shows Down arrow being pressed).

Figure 3-11b Programming Rolling Code Figure 3-11c Programming Summary Counter
Information Information
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Figure 3-11d Programming Write Counter Information Figure 3-11e Programming IRC/WDT Informatio

Pressing the Down arrow again will return you to Source Code Checksum &
Code Option information as shown Figure 1-11a above.

3. Press the Mode button then press the Up/Down buttons to scan and select
the desired program mode functions and press the Mode button again to set
the selected mode (sample figures shows Down arrow being pressed).

P
e >
. il om

Figure 3-11f Setting Program Mode Initial Display

Figure 3-11g Setting Verify Mode Display

T

Figure 3-11h Setting Write Mode Display

Figure 3-11j Setting Blank Check Mode Display

* If target is a Flash IC, the “Setting Erase” mode will display at this interval. Otherwise it will skip to
“Initial Display” mode.
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4. With the target chip properly installed on Textool, press the red Program

button to start auto run.

5. Observe the Green LED extinguishes while the LCD displays the

programming progress status.

6. When programming is successfully completed, the buzzer will beep once

and the LCD will display *Pass*, while the LED lights up with a green light
at the same time.

7. If the programming result fails, the buzzer will beep twice and the LCD will

display *Fail*, while the LED lights up with amber color at the same time.

8. Remove the programmed IC, place another blank OTP/FLASH chip on the

Textool, and repeat the whole procedure.

3.5 Counter Report

The UWTR Writer device has two counters, the Write Counter

Tool | About
% Blank Check - and Summary Counter.
@ Ver F9 The Write Counter is displayed as a sub-window of the
Cﬂmﬂﬂfe UWriter main window as illustrated below. It counts and
43 Eind Cr+F | displays the total programming performed including the
| Counter Report  CirkR | number of successful and failed programming. After each
Log Setting Cl | source code loading, these numbers are reset to zero.
Writer Test Ctri+T
Customize...
uccess Fail Total
Figure 3-12a “Counter Report”
Command I 2 0 2
Figure 3-12b Write Counter Window
The Summary Counter is accessed by Counter Report X|
clicking the Counter Report ~Region
command from Menu bar ([Tool] = © Onfine ¢ Otfline
[Counter Report]). The Counter ~Summary
Report dialog then displays showing Smrzess | O
the Summary Counter. Unlike Write Fail: | 2
Counter, it also counts and displays the Total: | 819
total programming performed
including the number of successful and CReset close |

failed programming continuously
regardless of number of code loading
performed. It will only reset to zero when the Reset button of the dialog is
pressed.

Figure 3-12¢ Counter Report Dialog
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%ﬂﬂ

3.6 Programming of New Set of OTP/FLASH Chip

Program | Read Tool Abou
4 Select MCU Ctrl+M |
Set option...
| Load F2
&% Erase F3
& Irite F3
& Auto F4
@ Protect F10

Figure 3-13 “Select MCU”
Command

When switching into another set of target chip (with different
part number), you need to start the whole procedure again.
From the Main menu, click on [Program] - [Select MCU]
command. Then the Select MCU dialog (Figure 3-2a in
Section 3.1.1) will prompt you to enter your new target chip
part number. Refer to Sections 3.2 to 3.4 for the subsequent
procedures.

Note that when you switch to different set of chips, all the
data in RAM of PC are cleared. Also remember to replace the
Adaptor Board with compatible one before proceeding.

3.7 Erasing FLASH Chip Contents

Program | Read Tool Aboy
dey Select MCU Ctrl+3d
Set option...
4 Load F2
&% Erase F§ |
& Write F3
& Auto F4
@ Protect F10

Fig.3-14 “Erase” Command

To erase existing contents of FLASH chip, mount the chip on
UWTR Writer and click [Program] = [Erase] command
from the main menu.

Observe the Output window for the display of the progress
and result of the Erase command execution.

3.8 Rolling Code

3.8.1 Rolling Code Application

When the data of several fixed addresses in each one of the programmed chips
need to be individually unique for easy tracing or other identification purposes,
the Rolling Code feature is the answer for such application.

3.8.2 ROM Codes Data that are Applicable to Rolling

Code

If the ROM code instruction is one of the following;

MOV A,K
RETL K

Then, Rolling Code can be applied. Rolling Code will modify the “K” byte.
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3.8.3 Setting

To use Rolling Code, you have to setup its pertinent options for loading in the
Load dialog as shown below.

Where:

count:

oad_______________ x|
Load Region
+ Online " Offline [V Load with EEFROM Data
count 10000 (Dec) (0= unlimited )
- Rolling Code

v Use Rolling Code for ROM Codes
ROM Codes |

Rolling Code Bytes: I 4 LlLl

rAddresses (He)
SthByte TthByte fthByte SthByte 4thBwyte 3rdByte 2ndEwte LowByte

[ ooo [ aooo | 0000 | oo | 0aog | 0006 | 04 | 0002

High byte address <<= Low biyte address

cutrent I 1234 (Hex) step I il (Hex)

e

Figure 3-15 Rolling Code Setup in Load Dialog

Set the quantity of chips to be programmed for this particular Load
session. If Rolling Code is not used, you can still give a number limit
of count. But for Rolling Code application, you must provide a
quantity value and you cannot set this count to zero. In addition, the
count cannot exceed the upper bound or exceed reasonable value
(count * step + current must be less than the max value that Rolling
Code bytes can accommodate). Count is a number.

Rolling Code Bytes: Is the number of instructions needed to be modified by

Rolling Code. Each instruction has one byte (K) that can be
modified. Minimum bytes in a Rolling Code is 2, maximum is 8.

Address (Hex): Sets the addresses of instructions that need to be modified by

current:

step:

Rolling Code. Please take note of the address high & low
relationship. Address is a hexadecimal number.

Sets the start value to be modified with in each “K” byte. “current”
Is a hexadecimal number.

Sets the increment value to be added at “K” byte after programming
of each chip. “step” is a hexadecimal number.

UWTR Writer User’s Guide
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& Examples:

The following source code is based on the Rolling Code setting the Load dialog
shown in Figure 3-15 above. Please take note of each value entered in each text
boxes of the Load dialog.

MOV A, @OxFF ; address 0Ox2
NOP ; address 0x3
RETL @OxFF ; address 0x4
NOP ; address 0x5
MOV A, @OxFF ; address 0x6
NOP ; address 0x7
RETL @OxFF ; address 0x8

As the current initial value is 0x00001234, the following source code is written
to the first chip.

MOV A, @0x34 ; address 0x2
NOP ; address 0x3
RETL @0x12 ; address 0x4
NOP ; address 0x5
MOV A, @0x00 ; address 0x6
NOP ; address 0x7
RETL @0x00 ; address 0x8

As the incremental value change is 0x1234+0x51=0x1285, so the following
source code will be written the second chip.

MOV A, @0x85 ; address 0x2
NOP ; address 0x3
RETL @0x12 ; address 0x4
NOP ; address 0x5
MOV A, @0x00 ; address 0Ox6
NOP ; address Ox7
RETL @Ox00 ; address 0x8

These steps are repeatedly written to subsequent programmed chips until
the10000th chip is reached. If you want to start another writing scheme, set up
new setting in the Load dialog again.

32 e Getting Started with UWriter System UWTR Writer User’s Guide



= Chapter 3

3.9 Updating UWTR Firmware

Normally, the UWriter program has to match with UWTR firmware and both
should have the same version number. If the UWriter version is older than that
of UWTR firmware, connection between PC and UWTR cannot be established.
You must download and install the latest version of the UWriter program in this
case.

If the UWriter program is of newer version than that of UWTR firmware,
connection between PC and UWTR can be accomplished, but the UWriter will
immediately prompt you with an UWTR firmware update notice (see below)
upon establishing connection.

UWriter x|
& Prepare to update UWTR firmw are.
Da NOT tum off UWTR pawer ar discarmect its USB cable.

Cumrent UWTR firmware version: $.09
The carrect version needed to update: €.10

Press OK to update the UWTER fomware.

Figure 3-16a UWTR Firmware Update Notice

When updating the UWTR firmware, be sure the UWTR power is on and is
connected to PC via USB cable as warned in the Output window.

Do NOT turn off UWTR power or disconnect its USB cable.
Start to Load WTR firmare data......

Loading UWTR firmware data Succeeded.

Start to Update UWTR firmare.

Please wait

Figure 3-16b UWTR Firmware Loading Messages

After updating the UWTR firmware, UWriter will try to reconnect with UWTR.
You can hear a beep sound and see “Connecting Succeeded” and “Updating is
over” displayed in the Output window.

Wait, connecting in progress...
Connecting Succeeded.

Updating is over.

Figure 3-16c UWTR Firmware Successful Loading Messages

WARNING!
Do NOT turn off UWTR power or disconnect its USB cable during UWTR firmware updating
process. If UWTR lost its power during updating process, UWTR device might be damaged
and have to be sent back to ELAN.
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If for some reasons, you really need to reinstate the old firmware version into
UWTR, click this command [About]->[Force to reinstate the old firmware
version into UWTR] from the Main menu. However take note that this it is

NOT recommended.

about |
Help Fl
History

| Force to reinstate the old firmware version into UWTR |
License

@ pbout

Figure 3-16d Reinstating Old UWTR Firmware Command
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Chapter 4

Other UWriter
Software Functions

4.1 Modifying Window Layout

Except for Output sub-window, all other sub-windows of UWrter can be
repositoned, semi-hidden, completely hidden, or made to float on the main
window.

4.1.1 Repositioning Sub-Windows with Title Bar Tools

Each sub-window is equipped with 3 smal icons at the right end of the title bar
(illustrated beow) which can be used as tools for changing its position in the
main window.

Figure 4-1a Sub-Window Repositioning Tools

= Clicking this tool will allow you to switch the sub-window into either
“Floating”, “Docking”, “Auto Hide”, or “Hide” format.

n Clicking this tool will allow you to switch the sub-window between
“Auto Hide” and “Docking”.

Clicking this tool will allow you to hide the sub-window.

. . . . i Pr Read Tool About
To re-display a hidden sub-window, click Ze‘;lnd;ir}fdb;a A
[View] from the Menu bar and enable the (] status Bar
check box of the of the pertinent sub-window. [-] Coje Options anddchecksum Ctri%
. . - v | Code Opti [
Executing Reset window layout will restore 7] broganmed o o
the main window default layout [ Source Ctl 4
| v | Bead Cirl+5
[v| EEPROM Source Cirl+6
[~| EEPROM Read Cirl+7

Reset window layout |
Sync Focus
Figure 4-1b “View” Sub-Menu
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4.1.2 Repositioning by Dragging Sub-Windows

B Docking into new position with docking assistance icons

You can drag and drop a window to the new position by clicking and dragging
on the title bar of a sub-window. The “docking assistance icons” (see figure
below) will appear as you drag the sub-window. “Main window docking icons”
appear at four sides of the main window, while “Sub-window docking icons”
appear at the center of the sub-window you are approaching. The docking icons
mark the positions where you can drop the the sub-window you are dragging as
further illustrated below.

Dropping the cursor at this “Main window
docking icon” will reposition the dragged

sub-window at the left side-most position
of the main window

Dropping the cursor at this “Main window
docking icon” will reposition the dragged
sub-window at the top-most position of the
main window

- UWriter version: 0.10.05 - EM78P159NP N EIES
¢ Fle Wiew [Program Read Tool About
g o Wl e N & & & | % P o4l e
* Open  Close  Saveas.. Select MCU  Load  Frase  Wiite otect | Read Chip | Elank Check Verify  Find About ﬂ_
| | i
| e | oy U\Il‘z\lﬁ\4\5\6|?|8\9|A|B\CID\E\FH
ROMCEdESClECkSuIn FCOO FCOO o IWIFFP‘ 1FFF 1FFF 1FFF 1FFF IFFF 1FFF 1FFF 1FFF 1FFF I1FFF 1FFF 1FFF
10 | 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF IFFF 1FFF 1FFF 1FFF 1FFF
Cade Optimle'd 0 1BFF IBEF —
20 | 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 11<'FF_'I
Code Optiof Word 1 1FFF 0338
Code Opliln Ward 2 LFFF 1FFF
Prftect Dissble Dissbls Success ‘ Fail | Total ‘
iLP High High a a Q
olmuam HET(High ETAL) IRC(Intermal RC) PSSIOSCO acts a5 OF

I i \Vgﬂ Dusile Dustte Source and Chip ROM codes are the same.
CL] delocks delocks -
7@‘}& ¥ 455KHz >
GY: Zeyeles leycle
%UT Syst Ik o . o 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF lF}\y
== e 10 1FFF 1FFF 1FFF 1FFF|
Custom ID{HEE) 1FFF 1FFF
T | _'I 20 1FFF 1FFF 1FFF 1FFF|
. 30 1FFF 1FFF 1FFF 1FFF|
Dropping the cursor at one of these “sub-window “0 L N S
. . [ i 50 IFFF 1FFF LFFF 1FFF|
docking icons” will reposition the dragged
. . N L) 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF|
sub-window at thc_a top, bottom, rlght S|df_e, or left__ =il i el e e | et e e
side of the sub-window in focus 80 1FFF 1FFF IFFF 1FFF LFFF IFFF 1FFF LFFF 1FFF,
(see figure below where cursor is dropped at the 20| 0 IFFF  IFE LFFIFFF LT IEFIFF 16
I’I ht Slde ICOH) A0 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF|
It.oae Uption wor 2 | 1 1 PO R | g 11 L o1oarer ‘ EO |;—|1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF|
u il 1 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF 1FFF|
Ready [ e I e I e e e e

Start to Read from Chip

Figure 4-2a Main Window Showing How to Use the Docking Assistance Icons

Start to Load
Loading to buffer Succeed: u
Start to Read from Buffer
Reading from Buffer Succeeded.

Start to Load
Loading to buffer Succeeded.
Read from Buffer

3 =

Start to
Reading from Buffer Succeeded.

1414 1FFF 1FFF 1FFF

‘ o

Source and Read ROM codes are the same. Source and Read ROM codes are W |G s G amE)
20 | 183F 0044 00CO 01C4
30 | 00OB 1800 00OC 18FF
40 | 1443 00D2 0AS0 0012
K on| (]
50 | 145F 00DS 0OCE 0885
60 | 0046 1479 DESO 1479
70 | 1810 0048 1479 1820
183F 0044 00CO g0 | DE83 148B 04l4 0354
0QO0E 1800 OO0OC 1SFF 90 |18F4 0117 OE83 1458
1443 0 0450 0012 40 | IFFF 1FFF 1FFF 1FFF
143F Uu 0oce 0885 ‘I - I j El 1FFF 1FFF 1FFF 1FFF_T
W 4 b W Message |~ e M 4 b o ' Message 4 Find A Compare 4 »
»
Ready 00% 4

Figure 4-2b Docking a Sub-Window at Right Side of the “Sub-Window Docking Icons”
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B Merging sub-windows

If you want to merge two or more sub-windows into a single sub-window
position, drag and drop the title bar of the sub-windows to be merge into
the recipient sub-window. The sub-windows are merge into tab sheets.
Active sub-widow changes as you select and click which sub-menu to
activate from the tabs.

The Output window has no title bar, so you cannot merge any sub-
window into Output window nor the other way around.

B Transforming sub-window into floating mode

If you want a sub-window to float on the main window, click and hold on
its title bar, then move the cursor slightly without releasing the mouse
button. When the sub-window transforms into miniature sub-window,
drag and drop it to float at any area of the main window but away from any
of the docking assistance icons.

4.1.3 Reset Window Layout

¥iew | Brogam Read Tool About If you want to reset window layout to the default status, just

Standard Toolbar
Status Bar

Code Cption Word
Frogrammed Counter
Source

Eead

EEPROM Source
EEFEOM Read

[ eIl L <]

click [View]>[Reset window layout] command of main

Code Options and Checksum  Ctil+l menu.

Ctil+2
Ctil+3
Ctil+4
Cil+5
Ctil+6
Ctil+7

Reset window layout

Sync Focus

Figure 4-3 “Reset Window
Layout” Command
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4.2 Finding a Specific Content

42.1 Find Command

Tool | About You can find the specific value or address in the Find dialog
%~ Blank Check F5 (figure below). Access Find dialog by clicking [Tool] >
B Verify Fo [Find] command from Menu bar.

Compare x|
|,:ﬁ Eind Chrl+F || o | & Value

ind:

Counter Report Ctri+R © Address

Log Setting Cerl+L Window Selection Radix

Writer Test Cr+ T * Source Window & HEX

Font... " Read Window  DEC

Customize... ¢ EEPROM Source Window © oCcT

Figure 4-4a “Find” Command " EEPROM Read Window T BIN
0K I Cancel

Figure 4-4b “Find” Dialog

Options are for Source Window, Read Window, EEPROM Source Window,
and EEPROM Read Window. Select VValue to find a specific value you want.
You can enter hexadecimal number, decimal number, octal number, or binary
number. The results can be found in the Output window (shown below) after
pressing the OK button. Double clicking at any of the result lines will link and
jump to its corresponding address automatically.

Source Window: Found in address 0002Z4H
Source Window: Found in address 000ZDH
Source Window: Found in address 00031H

3 occurrence|(s) hawe been found in Source window.
M 4 ¥ w4 Messaze Find 4 Compare 4 Comment o

Figure 4-4c Find “Value” Results Shown in the Output Window

The other option is to find a specific address by selecting Address in the Find
dialog. This method will jump to the address you are looking for directly.
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4.2.2 Sync Focus

View | Program Read Tool About
Z Standard Toolbar

z Status Ear

Code Options and Checksum  Ctil+l
Z Code Option Word Cirl+2
Z Frogrammed Counter Ctrl+3
[v] Source Ctil+4
[v] Read Ctrl45
[v| EEPROM Source Ctrl46
[v| EEPROM Read Ctrl+7

Eeset window lavout

Sync Focus

Figure 4-5 “Sync Focus” Command

Sync Focus means that the focus changes in the Source and
Read sub-window are synchronal. For example, when you
click Address 0x123 in Source sub-window, the Read
sub-window will jump to 0x123 immediately. It can help you
compare the contents of the two sub-windows. EEPROM
Source and EEPROM Read sub-windows are affected by

this option too.

The default setting of this option is enabled. If you want to
disable this option, click [View] = [Sync Focus] command

from the Menu bar.

This option also affects the jJump function when double clicking on the Output sub-window

address

4.3 Log Setting

Tool | About

&% Blank Check F5

& Verify Fa
Compare

#4 Find Crrl+F
Counter Report Ctri+R

| Log Setting Ctri+L
Writer Test Ctri+T
Font...
Customize...

Figure 4-6a “Log Setting” Command

You can write data to log file when you are operating online
by clicking [Tool] = [Log Setting] command from Menu
bar. The Log dialog then appears (figure below).

Log Recording Moment:

¥ Verify

¥ write [include Auto]

Product Code Mame: |1 234

Log File: |1ua\%ﬁ\Uwriler Log\0910121019_1234_EM7BF664ANK24.tt  Set Path

 Log Option
¥ EM No.

¥ Verify Result

v Source Code Name

v Time

¥ IRCAWDT Frequency [ Over Range? )

¥ Read Word 0 to Word A

¥ Source

¥ Read

¥ ROM Checksum

¥ Protect

¥ EEPROM Checksum

™ Code Option Words

~Rolling Code Setting

Vv ROM
™ EEPROM

I~ Address [~ Current ‘

0K |

Cancel |

Figure 4-6b “Log Setting” Dialog

The Uwriter will generate the following Log File format after you enter the
Product Code Name in the edit box:
“Time_ Product Code Name_MCU Name.txt”
Where “Time”: is the time when you opened the Log Setting Dialog. The
default path that stores the log file is -
“C:\Documents and Settings\Username\Desktop\Uwriter Log”

You may click the Set Path button to change the default path.
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The first options on this dialog is explained below:

Verify: Write log file when executing “Verify”.

Write (include Auto): Write log file when executing “Write” or “Auto”.

Then, you have to enter the product code name. The UWriter will generate the
log file automatically according to the product code name you have entered in
the current log file path. If you want to change the log file path, click the Set
Path button and select a path you want.

Finally, select the data you want to write into log file and press the OK button.

NOTE
The Rolling Code Setting data can be written to log file only when the “Write [include Auto)”
check box has been selected.

For outsourced factory firmware, the “Verify” checkbox is pre-selected by
default and you cannot disabled it. The “Write [include Auto]” check box can
disabled or enabled according to actual requirement.

4.4 UWTR Self Test

Tool | About The UWTR Self Test function tests all the parameters of
&% Blank Check F5 UWTR. You can use this function to determine whether the
& Verify Fa | UWTR is working properly.
S You should install the test board and connect the UWTR to PC
#4 Find Cer+F | first and then click [Tool] > [Writer Test] to execute the Self
Counter Report Ctri+R Test function.
Log Setting Ctri+L
| Writer Test Ctri+T |
Font...
Customize...

Figure 4-7 “Writer Test” Command
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4.5 Font Setting

Tool | About

@ Blank Check F5

&R Verify F2
Compare

&4 Find Ctri+F
Counter Report Ctri+R
Log Setting Ctrl+L
Writer Test Ctrl+T
Font...
Customize...

Figure 4-8a “Font...” Command

You can change the font type and size of text for each
sub-window by clicking [Tool] = [Font] command from
Menu bar. The resulting Font... dialog is shown below.

x|
Window Font Size

Courier New
Times New Roman
Times New Homan

Li]
8
Li]
EEPROM Source Times New Roman 8
EEPROM Read Times New Homan 8
Code Options and Checksum Times New Roman 8
Code Option Word Times New Homan 8
Programmed Counter Times New Roman 8
st | [ ma ]

Figure 4-8b “Font” Dialog

Select by clicking the sub-window with which to change its font from the
Window list box. You also can select a group or range of sub-windows by
pressing Shift key while selecting. To remove a single sub-window from the
selected ones, click while pressing Ctrl key. To add a single sub-window to the
selected ones, also click while pressing Ctrl key.

Then press the Set button to display the Windows standard font setting dialog.
You can freely change the font type and its font size settings. All selected
sub-windows will be set with the new font type together.

4.6 Customizing UWriter Ul

Tool | About

@5 Blank Check F5

&R Verify FQ
Compare

#4 Find Chrl+F
Counter Report Ctri+R
Log Setting Ctrl+L
Writer Test Ctri+T
Font...
Customize...

Figure 4-9a “Customize...” Command

To customize the UWriter user interface, click [Tool] -
[Customize...] command from Menu bar. The Customize
dialog will displays with its five tabs as shown below.

Customize X|
Commmands | Toolba:rsl Keyboard | enu | Optinnsl
Categories: Conumands:
jom [ Open...
Read [ Clos=
Tool
Aot ol Bave as...
Mew Menu 2 o
Al Comumands CRIEE
Exit
Description:
'Q_V,'l Cloze

Figure 4-9b “Customize” Dialog with the “Commands” Tab Active

UWTR Writer User’s Guide

Other UWriter Software Functions e 41



Chapter 4

46.1 Commands Tab

Select “Commands” tab (illustrated above) to display all available UWriter
commands under the selected category. Then drag and drop a command into
Toolbars, Menu bar, or into a Drop-down command menu (from Menu bar). To
restore default settings, go to Toolbars tab and click Reset All button.

4.6.2 Toolbars Tab

Custamize X|
Commands  Toolbax: |Key'boa.rd | Memn | Opti.onsl
Eest |
Reset A1 I

[+ Show ezt labels

@ | Clase

Figure 4-10 “Customize” Dialog with the “Toolbars” Tab Active

The Toolbars tab allows you to enable/disable the “Tool Bar” but not the
“Menu Bar.” However, if you click Reset or Reset All button, either toolbar,
or both can be reset to its default settings. You can also restore/remove the text
labels from all icons in the Toolbar by toggle clicking on the Show text labels
check box.

4.6.3 Keyboard Tab

Customize X|
| Menn | Opti.onsl

Categony: Set Aceelerator for:
| File 1 O = =|

Current Kewrs:

Crl+ W i |
Eemaie |

Press Hew Shortcut Ke: Rest Al |

Description: l—

Cloze the active source file

@ | Close

Figure 4-11 “Customize” Dialog with the “Keyboard” Tab Active
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The Keyboard tab allows you to create/remove shortcut keys for the commands
of a selected command category. The procedure is explained below:

B Creating a shortcut key

After selecting a Category and Commands option from their respective boxes,
enter your custom shortcut key into the Press New Shortcut Key text box.
UWriter will auto—detect whether the new shortcut key has already been
assigned or not. If it has already been assigned, the pertinent command name
(with which the shortcut key is currently assigned) will display under a pop-up
Assigned to: field and you need to directly enter another shortcut key.
Otherwise, [Unassigned] will pop-up. Then click Assign button to apply.

If the Assigned to: field displays question marks (???7?), it means the shortcut
key you just entered is reserved and is not user definable.

B Removing an existing shortcut key

After selecting a Category and a Commands option from their respective
boxes, the corresponding command shortcut key (if available) will appear in the
Current Keys box. Select the corresponding shortcut key and click Remove
button to delete.

B Restoring all shortcut keys to their default settings:

Click Reset All to reset all command shortcut keys to its default settings.

4.6.4 Menu Tab

Customize x|
Commandsl Toolbarsl Keyboard  Menu |Op1i0ns|

— Application Frame Menus:

Diefanlt application menu.
A ppears when no documents are
open.

IMenu andmations: INDm -I

¥ Menu shadows

(7] | Cloz

Figure 4-12 “Customize” Dialog with the “Menu” Tab Active

If you want to reset the Menu bar, press Reset button from this tab. This
function is similar with that of Toolbar tab desribed in Section 4.6.2 above.

In addition, you can add animation feature to the drop-down command menu of
Menu bar by selecting an option in the Menu animation drop-down list box.
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4.6.5 Options Tab

Customize

Figure 4-13 “Customize” Dialog with the “Options” Tab Active

Use the Options tab to set the size of the toolbar buttons and specify whether to
display screen tips and shortcut keys (where applicable) when pointing at the
button.
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G
Appendix A
UWriter Supported ICs

A.1 EM78 Series Supported by UWriter Version 1.04.00
or later

A.1.1 OTP Type

EM78P131A
EM78P418N

EM78P134N EM78P152SN EM78P163N EM78P164N

A.2 EM78 Series Supported by UWriter Version 1.03.00
or later

A.2.1 FLASH Type

EM78F541N
EM78F562N
EM78F651N

EM78F542N
EM78F564N
EM78F652N

A.2.2 OTP Type

EM78P132
EM78P1541N
EM78P311N
EM78P349N
EM78P520N
EM78P809N

EM78P141
EM78P202N
EM78P312N
EM78P458
EM78P570

EM78F544N
EM78F568N
EM78F668N

EM78P142
EM78P210N
EM78P330N
EM78P459
EM78P5840N

EM78F548N
EM78F641N
EM78F672N

EM78P143
EM78P220N
EM78P331N
EM78P469
EM78P5841N

EM78F561N
EM78F648N

EM78P153A
EM78P256N
EM78P342N
EM78P507N
EM78P5842N

A.3.1 FLASH Type

EM78F642N

EM78F644N

EM78F661N

EM78F662N

A.3 EM78 Series Supported by UWriter Version 1.00.00
or later

EM78F664N

UWTR Writer User’s Guide
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A.3.2 OTP Type

EM78P153S EM78P154N EM78P156EL EM78P156N EM78P157N
EM78P159N EM78P257 EM78P259N EM78P346N EM78P447N
EM78P447S EM78P451S EM78P468L EM78P468N
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